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ASCENDER Updates

ASCENDER Releases
• Several updates over the summer
• Recent Update - 9.1211 (installed on 8/25/25)



Payroll

• Modified various Payroll reports in the following processes to 
include the Pay Campus and Pay Dept columns. The column 
data originates from the Pay Campus and Pay Dept fields on the 
Payroll > Maintenance > Staff Job/Pay Data > Pay Info tab. The 
report sorting will remain the same with the addition of the new 
columns.

• Payroll Processing > Run Payroll > Payroll Calculations
• Payroll Processing > Payroll Adjustments > Check Issue
• Payroll Processing > EOY Payroll Accruals > Run Calculations
• Next Year > Interface NY Payroll to NY Budget > Calculations
• Zero School YTD Accrual Retiree Surcharge Extract
• Utilities > Payroll Simulation > Calculations
• Utilities > Payroll Accrual Variance Extract > Extract
• Utilities > Zero School YTD Accruals > Extract



Payroll

• Removed the following reports that are not available in CSV format:
• Payroll Processing > EOY Payroll Accruals > Mass Delete
• Utilities > Payroll Accrual Variance > Extract
• Utilities > Zero School YTD Accruals > Extract



Reminders

Things to Remember



Reminders

• IMS Website & IMS Business Login
• Username: IMSBusiness
• Password: busims16ESC!



Reminders

• Reviewing IMS Business 
Announcements, Information, 
and Videos

• Relevant information, updates, 
and important changes are 
shared in IMS Business 
announcements and the IMS 
Business website.

• Verify that you are signed up and 
follow/review this information to 
be aware of important changes 
and updates. These can include 
changes from TEA, TRS, 
ASCENDER, etc.



Reminders • Subscribe to IMS 
Announcements

• Log into the IMS Business 
Homepage

• Click on Subscribe to IMS 
Announcements, fill out 
form, and submit



Reminders • New District Employee 
Information Form

• Let us know about new 
employees or changes in 
staff who use ASCENDER

• Log into the IMS Business 
Homepage

• Click on New District 
Employee Form, fill out 
form, and submit



Reminders

Check Signature in ASCENDER
• Template document under 

Documentation on IMS 
Business website

• Must upload cropped image 
(from template) into 
ASCENDER

• District Administration > 
Tables > Electronic Signatures



Reminders
August TRS Update

• Includes important 
information, reminders, 
and updates

• August 2025 Update

Also, remember to review the 
updates for June and July.
• June 2025 Update
• July 2025 Update

https://issuu.com/docs/a44d340884f640af1be73cbbe5627aa1?fr=sZTZlNjg1ODU0MTE
https://issuu.com/docs/a44d340884f640af1be73cbbe5627aa1?fr=sZTZlNjg1ODU0MTE
https://issuu.com/docs/c469f147b80b205ebc4b4df879ccf7b7?fr=sYWIxNjg3MjIyNjY
https://issuu.com/docs/c469f147b80b205ebc4b4df879ccf7b7?fr=sYWIxNjg3MjIyNjY


Reminders

Let’s take a closer look at 
some of the topics from the 
June and July TRS Update 
Newsletters.



Reminders



Reminders



Reminders

• Non-Standard Work Week
• Payroll > Utilities > TRS Maintenance > Employee Data (ED) > ED40 (Contract and Position)
• If an employee is working a non-standard work week, then the Non-Standard Work Week checkbox 

needs to be selected.
• A non-standard work week occurs when the employee is regularly scheduled to work fewer than five 

days per week.
• If your district has a 4-day week or a hybrid of these, then this checkbox will need to be 

checked on the employee’s ED40 record.
• Please note it must be manually marked.



Reminders

• New TRS Contribution Rates
• Payroll > Tables > Tax/Deduction Rates > TRS 

Rates > 2026



Reminders

• IRS Salary Cap Provision for 2026
• Payroll > Tables > Tax/Deduction Rates > 

TRS Rates > 2026



Reminders

• UID Staff Extract
• Personnel > Utilities > Texas Unique Staff ID Interface

• Update School Year to 2026 before running Staff ID Export
• Remember to add Termination Dates to student workers and temporary employees 

before extracting Unique IDs. 
• Also, this also serves as a reminder to add a Termination Date to other employees that are not 

returning to the district for this school year.



Reminders • Service Records
• All leave for 2024-2025 

should be entered and 
posted prior to completing 
service records.

• All service records should 
be completed prior to 
moving NYPR to CYPR.



Reminders
• Load Employee Benefits file prior to September payroll

• Payroll > Utilities > Employee Benefits Interface
• See ASCENDER Help for instructions on how to 

Import Annual File

https://help.ascendertx.com/business/doku.php/payroll/utilities/employeebenefitsinterface/import


Reminders

• Verify State Minimum prior to September payroll
• TEA 2025-2026 Minimum Salary Schedule 
• IMS Business Announcement sent on 7/31/2025 – 2026 State Minimum Tables
• IMS Business Announcement will be sent later this week – Updated State Min Tables

• Minor change needed: Table C, Step 5 should be:

• Can update the specific field manually or can re-import the updated table which will be 
available on our website when the announcement is sent this week

• Run a User-Created report using the following parameters:
• Employee Number, First Name, Last Name, State Step, and State Minimum Salary fields

• Ensure State Step and State Min Salary amounts are correct

https://tea.texas.gov/texas-educators/salary-and-service-record/minimum-salary-schedules
https://tea.texas.gov/texas-educators/salary-and-service-record/minimum-salary-schedules
https://tea.texas.gov/texas-educators/salary-and-service-record/minimum-salary-schedules
https://tea.texas.gov/texas-educators/salary-and-service-record/minimum-salary-schedules
https://www.esc16.net/apps/news/article/2090229
https://www.esc16.net/apps/news/article/2090229


Reminders
• Teacher Retention Allotment (TRA) & Support Staff 

Retention Allotment (SSRA)
• TEA Webpage on House Bill 2
• House Bill 2, Article 1 – Teacher Compensation - FAQ
• IMS Business Announcement sent on 6/16/2025
• IMS Business Announcement sent on 8/20/2025

https://tea.texas.gov/about-tea/government-relations-and-legal/government-relations/house-bill-2
https://tea.texas.gov/about-tea/government-relations-and-legal/government-relations/house-bill-2
https://tea.texas.gov/about-tea/89thlege-hb2-faq-teacher-compensation-updated-june-26.pdf
https://www.esc16.net/apps/news/article/2081594
https://www.esc16.net/apps/news/article/2081594
https://www.esc16.net/apps/news/article/2097035
https://www.esc16.net/apps/news/article/2097035


Reminders

• New Employees or Job/Position Changes
• Remember to consider the following for new employees:

• Will receive an email notifying the employee that banking information has changed
• Note: This email is sent to the employee any time banking info is added or 

changed.
• What to consider for anyone changing positions:

• Are the FICA/Medicare options set correctly?
• Is the employee eligible for TRS?
• Is the employee a retiree? If so, is the employee subject to surcharges? Are 

those surcharges marked?



Reminders

• Payroll Accrual Variance Extract
• Payroll > Utilities > Payroll Accrual Variance Extract
• It is recommended to run:

• After September payroll
• Monitor every month

• Note: ASCENDER may show errors on the first run 
where you are asked to update some of the 
information under Tax/Deductions for Calendar Year 
2026. We recommend using 2025 information for 
now.

• Remember to update any applicable 
information prior to the first payroll of the 
calendar year (January 2026).



Reminders

• Commodity Codes in Purchasing
• ASCENDER Using Commodity Codes guide

• This document will guide you through the 
necessary steps to set up and use commodity 
codes in ASCENDER.

https://help.ascendertx.com/business/doku.php/academy/business_guide_purchasing_commodity_codes


Reminders • Security Administrators
• Review users, roles, and 

permissions in the Security 
Administration application to 
ensure that all information is 
current.

• The Zoom training was 
provided earlier in July.       
The link to this recording is 
available upon request.



Reminders

• Missed the August End of Year workshop?
• Go to ASCENDER Help > Business Guides and Checklists for documentation on 

the processes covered. The guides are also linked below:
• End-of-Year Flowchart for September Start LEAs
• End-of-Year Payroll Verification
• August Accruals
• August TRS Reporting
• Finance End-of-Year Process
• First Payroll of the School Year (September Start LEAs)

https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/lib/exe/fetch.php/end-of-year_flowchart_for_september_start_leas.pdf
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augustaccruals
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augustaccruals
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augusttrsreporting
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augusttrsreporting
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_payroll_firstpayrolloftheschoolyear
https://help.ascendertx.com/business/doku.php/academy/business_payroll_firstpayrolloftheschoolyear


Reminders

• ESC-16 ASCENDER Ticket System – Important Reminders
• Your district email address is your username.

• If you forget your password, click the Forgot your 
Password? link on the ticket system login screen to reset it. 

• Reminder: You cannot respond to the ticket by replying to 
the email notification for your ticket. 

• To respond to the ticket, you must click on View 
request link in your email notification for the ticket 
and log into the ticket system, or you can log into the 
ticket system, select your ticket and respond there.



Upcoming Trainings

Webinars & In-Person



TEA Student Attendance 
Accounting Handbook Audit 
Review (In-Person)

• September 11th @ 9:00am – 4:00pm
• Region 16 ESC, Bell Street Location (Lecture Hall)
• Session #: 1029850

• Speakers
• Justin Jons

• Manager of Student Attendance & Financial 
Compliance Division

• Joe Herrera
• Manager of Student Attendance Accounting 

Handbook & SHARS Financial Compliance 
Division

https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1029850


2025-2026
IMS Business Trainings



411 Webinars
(Begin at 10:00am)

• September 24th 
• Session #: 1031746

• October 29th  
• Session #: 1031760

• November 19th 
• Session #: 1031771

• December 17th 
• Session #: 1031785

https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031746
https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031760
https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031771
https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031785


IMS Business Training
(Zoom)

• Business – New User Overview
• September 25th @ 9:00a-

11:00
• Session #: 1031749

• Purchasing - New User 
Overview

• September 30th @ 9:00a-
11:00

• Session #: 1031751

https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031749
https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031751


IMS Business 
Training
(Zoom)

• Personnel & Payroll - New User 
Overview & New Employee 
Setup

• October 27th @ 9:00a-11:00
• Session #: 1031752

• Payroll Processing for New Users
• October 27th @ 1:30p-3:30

• Session #: 1031756

• TRS Reporting Process for New 
Users

• October 28th @ 9:00a-11:00
• Session #: 1031759

https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031752
https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031756
https://www.escweb.net/tx_r16/catalog/session.aspx?session_id=1031759


• June 23-25, 2026
• Will be held in San Antonio, Texas
• Early Bird Registration will open September 1, 2025 

for $300
• Sessions are presented by ASCENDER consultants from 

around the state
• This user conference will be business only

2026 ASCENDER Business
Conference



Thank you 
for attending!

Need assistance?
Please enter an ESC 16-ASCENDER Ticket here.

This link can be found on all areas (Business, Student, 
TSDS/PEIMS pages) of the IMS website as well.

For TSDS/PEIMS related questions, please enter a TIMS ticket.

Please fill out a brief 3 question survey (by scanning the QR code) 
to help us improve the next Monthly 411 webinar. Thank you!

https://escsupport.ascendertx.com/servicedesk/customer/portal/28


Helpful Links

• End of Fiscal School Year Help Documentation:
• End-of-Year Payroll Verification
• August Accruals
• August TRS Reporting Process
• Finance End of Year Process
• First Payroll of the School Year

• June TRS Update and July TRS Update (August TRS Update not 
yet available as of 8/27/25)

• Register for Trainings: IMS Business Trainings

• Subscribe to Announcements: IMS Announcements
• New District Employee/Position Change Information Form

https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_eoypayroll_verification
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augustaccruals
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augustaccruals
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augusttrsreporting
https://help.ascendertx.com/business/doku.php/academy/business_payroll_augusttrsreporting
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_finance_eoyprocess
https://help.ascendertx.com/business/doku.php/academy/business_payroll_firstpayrolloftheschoolyear
https://help.ascendertx.com/business/doku.php/academy/business_payroll_firstpayrolloftheschoolyear
https://issuu.com/docs/a44d340884f640af1be73cbbe5627aa1?fr=sZTZlNjg1ODU0MTE
https://issuu.com/docs/a44d340884f640af1be73cbbe5627aa1?fr=sZTZlNjg1ODU0MTE
https://issuu.com/docs/c469f147b80b205ebc4b4df879ccf7b7?fr=sYWIxNjg3MjIyNjY
https://www.esc16.net/ourpages/auto/2025/8/6/33455440457643720952/IMS%20Business%20Training%20List%202025-2026%20-%20Updated%20July%2030.pdf
https://esc16.us18.list-manage.com/subscribe?u=e79b591fbf69805fe1f3a782c&id=e2d90df7c8
https://docs.google.com/forms/d/e/1FAIpQLScHVhPCbG5CPp-3kYt7BCb6bwbWf12Uq9jf7aBIYUYkANI5Lg/viewform
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